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ご注意書き 

 

1. 本資料に記載されている内容は本資料発行時点のものであり、予告なく変更することがあります。当社製品

のご購入およびご使用にあたりましては、事前に当社営業窓口で最新の情報をご確認いただきますとともに、

当社ホームページなどを通じて公開される情報に常にご注意ください。 
2. 本資料に記載された当社製品および技術情報の使用に関連し発生した第三者の特許権、著作権その他の知的

財産権の侵害等に関し、当社は、一切その責任を負いません。当社は、本資料に基づき当社または第三者の

特許権、著作権その他の知的財産権を何ら許諾するものではありません。 
3. 当社製品を改造、改変、複製等しないでください。 
4. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説

明するものです。お客様の機器の設計において、回路、ソフトウェアおよびこれらに関連する情報を使用す

る場合には、お客様の責任において行ってください。これらの使用に起因しお客様または第三者に生じた損

害に関し、当社は、一切その責任を負いません。 
5. 輸出に際しては、「外国為替及び外国貿易法」その他輸出関連法令を遵守し、かかる法令の定めるところに

より必要な手続を行ってください。本資料に記載されている当社製品および技術を大量破壊兵器の開発等の

目的、軍事利用の目的その他軍事用途の目的で使用しないでください。また、当社製品および技術を国内外

の法令および規則により製造・使用・販売を禁止されている機器に使用することができません。 
6. 本資料に記載されている情報は、正確を期すため慎重に作成したものですが、誤りがないことを保証するも

のではありません。万一、本資料に記載されている情報の誤りに起因する損害がお客様に生じた場合におい

ても、当社は、一切その責任を負いません。 
7. 当社は、当社製品の品質水準を「標準水準」、「高品質水準」および「特定水準」に分類しております。また、

各品質水準は、以下に示す用途に製品が使われることを意図しておりますので、当社製品の品質水準をご確

認ください。お客様は、当社の文書による事前の承諾を得ることなく、「特定水準」に分類された用途に当

社製品を使用することができません。また、お客様は、当社の文書による事前の承諾を得ることなく、意図

されていない用途に当社製品を使用することができません。当社の文書による事前の承諾を得ることなく、

「特定水準」に分類された用途または意図されていない用途に当社製品を使用したことによりお客様または

第三者に生じた損害等に関し、当社は、一切その責任を負いません。なお、当社製品のデータ・シート、デ

ータ・ブック等の資料で特に品質水準の表示がない場合は、標準水準製品であることを表します。 
標準水準： コンピュータ、OA 機器、通信機器、計測機器、AV 機器、家電、工作機械、パーソナル機器、

産業用ロボット 
高品質水準： 輸送機器（自動車、電車、船舶等）、交通用信号機器、防災・防犯装置、各種安全装置、生命

維持を目的として設計されていない医療機器（厚生労働省定義の管理医療機器に相当） 
特定水準： 航空機器、航空宇宙機器、海底中継機器、原子力制御システム、生命維持のための医療機器（生

命維持装置、人体に埋め込み使用するもの、治療行為（患部切り出し等）を行うもの、その他

直接人命に影響を与えるもの）（厚生労働省定義の高度管理医療機器に相当）またはシステム

等 
8. 本資料に記載された当社製品のご使用につき、特に、最大定格、動作電源電圧範囲、放熱特性、実装条件そ

の他諸条件につきましては、当社保証範囲内でご使用ください。当社保証範囲を超えて当社製品をご使用さ

れた場合の故障および事故につきましては、当社は、一切その責任を負いません。 
9. 当社は、当社製品の品質および信頼性の向上に努めておりますが、半導体製品はある確率で故障が発生した

り、使用条件によっては誤動作したりする場合があります。また、当社製品は耐放射線設計については行っ

ておりません。当社製品の故障または誤動作が生じた場合も、人身事故、火災事故、社会的損害などを生じ

させないようお客様の責任において冗長設計、延焼対策設計、誤動作防止設計等の安全設計およびエージン

グ処理等、機器またはシステムとしての出荷保証をお願いいたします。特に、マイコンソフトウェアは、単

独での検証は困難なため、お客様が製造された最終の機器・システムとしての安全検証をお願いいたします。 
10. 当社製品の環境適合性等、詳細につきましては製品個別に必ず当社営業窓口までお問合せください。ご使用

に際しては、特定の物質の含有･使用を規制する RoHS 指令等、適用される環境関連法令を十分調査のうえ、

かかる法令に適合するようご使用ください。お客様がかかる法令を遵守しないことにより生じた損害に関し

て、当社は、一切その責任を負いません。 
11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを固くお

断りいたします。 
12. 本資料に関する詳細についてのお問い合わせその他お気付きの点等がございましたら当社営業窓口までご

照会ください。 
 
注 1. 本資料において使用されている「当社」とは、ルネサスエレクトロニクス株式会社およびルネサスエレク

トロニクス株式会社がその総株主の議決権の過半数を直接または間接に保有する会社をいいます。 
注 2. 本資料において使用されている「当社製品」とは、注 1 において定義された当社の開発、製造製品をいい

ます。 
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

ごあいさつ
PG-FPL2をお買い求めいただき、誠にありがとうございます。

本製品は、NECエレクトロニクス社製のフラッシュ・メモリ内蔵マイ
コン 78K0S/Kx1+に対して、プログラムの書き込み・消去を行うための
開発ツールです。

クイック・スタート・ガイドでは、開発環境のご紹介と、開発ツール
の使い方をサンプル・プログラムを用いて説明しています。本製品をご
使用になる前に、ご一読ください。

本製品に関する最新情報、およびPG-FPL2を使うために必要な無償ソ
フト・ツールは、弊社webサイトにて提供しています。

http://www.necel.com/micro/product/sc/lowpin/index.html

【本クイック・スタート・ガイドの構成について】
本ガイドは4つの章から構成されています。

1. はじめに
製品の構成、ソフトウェアの開発フローなど本ガイドを
お使いいただく際に必要な基本的な事柄について説明します。

2. 準備編
PG-FPL2のセットアップ手順や無償ソフト・ツールのインス
トールについて説明します。

3. 体験編
簡単なアプリケーション・プログラムの作成を通して、
弊社製開発ツールの使い方について説明します。

4. 応用編
フラッシュ・メモリの書き換え禁止機能と、サンプル・ボー
ドのブロック図をご紹介します。

はじめに



Page 2

はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

システム構成図

USBケーブル
(ミニBタイプ）

小ピン･マイコン用無償ソフト･ツール
- PG-FPL2用ｺﾝﾄﾛｰﾙ･ｿﾌﾄ
- 小ピン用ﾊﾟﾗﾒｰﾀ･ﾌｧｲﾙ

(PRM78F9324)
- ﾃﾞﾊﾞｲｽ･ﾌｧｲﾙ (DF789234)
- ｺﾝﾊﾟｲﾗ (CC78K0S)
- ｱｾﾝﾌﾞﾗ (RA78K0S[注2])
- ｼｽﾃﾑ･ｼﾐｭﾚｰﾀ (SM+ for 78K0S/Kx1+)
- ﾃﾞﾊﾞｲｽ･ﾄﾞﾗｲﾊﾞ･ｺﾝﾌｨｷﾞｭﾚｰﾀ

(Applilet[注3])

簡易ターゲットボード
NECエレクトロニクス社製
小ピン・マイコン搭載[注1]
KY1+(16pin)、KA1+(20pin)、
KB1+(30pin)

PG-FPL2本体

ターゲット・ケーブル

ダウンロード
・インストール

ホストコンピュータ

PG-FPL2のシステム構成図です。
点線で囲んだ部分は、本製品の添付品です。

フラッシュ書き込み、プログラム開発に必要なソフト・ツールは、弊社
webサイトから無償でダウンロードできます。

[注1] 78K0S/KB1+は、実装されていません。
[注2] 統合開発環境 PM+ を含みます。
[注3] Appliletは KA1+のみサポートします。

はじめに
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

統合開発環境 PM+ 

ビルド

プログラム作成手順と開発環境
プログラムの作成手順と、使用するソフト・ツールを紹介します。

コーディング 動作確認 書き込み

スタート

ﾃﾞﾊﾞｲｽ･ﾄﾞﾗｲﾊﾞ
･ｺﾝﾌｨｷﾞｭﾚｰﾀ
Applilet

Applilet：GUIを使った簡単な操作
で、ﾏｲｺﾝの内蔵周辺機能を動作さ
せるｿｰｽ･ｺｰﾄﾞを自動生成します。

PM+：ｿｰｽｺｰﾄﾞのﾋﾞﾙﾄﾞ、ｴﾃﾞｨﾀやｼ
ﾐｭﾚｰﾀの起動などﾌﾟﾛｸﾞﾗﾑ開発で
必要な一連の操作をまとめて行
うためのﾂｰﾙです。

CC78K0S：ANSI-C準拠したCｺﾝﾊﾟ
ｲﾗです。78K0S固有の拡張機能
をｻﾎﾟｰﾄします。
RA78K0S：78K0S用のｱｾﾝﾌﾞﾗです。

ﾃﾞﾊﾞｲｽ
ﾌｧｲﾙ

ﾃﾞﾊﾞｲｽ･ﾌｧｲﾙ：ﾏｲｺﾝの品種依存ﾃﾞｰﾀﾌｧｲﾙ
です。各ｿﾌﾄ･ﾂｰﾙが参照します。

PG-FPL2用
ｺﾝﾄﾛｰﾙ･ｿﾌﾄ

書き込み完了

ｼｽﾃﾑ･ｼﾐｭﾚｰﾀ
SM+ for 
78K0S/Kx1+

ﾊﾟﾗﾒｰﾀ
ﾌｧｲﾙ

ｺﾝﾊﾟｲﾗ
CC78K0S

ｱｾﾝﾌﾞﾗ
RA78K0S

ﾕｰｻﾞ
ﾌﾟﾛｸﾞﾗﾑ
記述

SM+ for 78K0S/Kx1+：ﾏｲｺﾝの動作
をｼﾐｭﾚｰｼｮﾝします。実機を使わず
にﾌﾟﾛｸﾞﾗﾑ動作の確認ができます。

PG-FPL2用ｺﾝﾄﾛｰﾙ･ｿﾌﾄ：PG-FPL2を操作するため
のGUIｿﾌﾄです。
ﾊﾟﾗﾒｰﾀ･ﾌｧｲﾙ：ﾌﾗｯｼｭ･ﾒﾓﾘの書き換え時に使用す
る品種依存情報ﾌｧｲﾙです。

はじめに



Page 4

はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

開発ツールのダウンロード

アイコンを
クリック!!

“小ピン・マイコン用無償ソフト・ツール”のインストール方法：

PG-FPL2用コントロール・ソフト、小ピン用Applilet
自己解凍形式のファイルを実行すると、フォルダが作成されます。

setup.exeを実行してインストールを行ってください。

SM+ for 78K0S/Kx1+、RA78K0S、CC78K0S
自己解凍形式のファイルを実行すると、自動的にインストールが
始まります。 画面の指示に従ってインストールを行ってください。

小ピン用デバイス・ファイル
専用のインストーラでインストールします。解凍したフォルダに
あるユーザーズ・マニュアルを参照して、インストールを行ってく
ださい。

小ピン用パラメータ・ファイル
任意の場所に解凍してください。

PG-FPL2を使うために必要な無償ソフト・ツールは、弊社webサイトに
て提供しています。

http://www.necel.com/micro/product/sc/lowpin/index.html

準備編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

PG-FPL2の接続方法

① MODEスイッチで、ﾀｰｹﾞｯﾄ･ｼｽﾃﾑへ供給する電源を設定します。

② USBケーブルで、PG-FPL2とホストコンピュータを接続します。
初めて接続する時は、USBドライバのインストール画面が起動します。
(次ページ参照）

③ Power LED が緑色に点灯していることを確認します。

④ PG-FPL2と、ﾀｰｹﾞｯﾄ･ｹｰﾌﾞﾙ(接続ｺﾈｸﾀ)を接続します。

⑤ ﾀｰｹﾞｯﾄ･ｹｰﾌﾞﾙを下記の順序に従って、ﾀｰｹﾞｯﾄ･ｼｽﾃﾑに接続します。

(5-A)“0.GND”と捺印されたﾀｰｹﾞｯﾄ･ｹｰﾌﾞﾙ先端部を、ﾀｰｹﾞｯﾄ･ｼｽﾃﾑの
“GND”と表示されたピン・ヘッダに接続します。

(5-B)“2.VDD”と捺印されたﾀｰｹﾞｯﾄ･ｹｰﾌﾞﾙ先端部を、ﾀｰｹﾞｯﾄ･ｼｽﾃﾑの
“VDD”と表示されたピン・ヘッダに接続します。

(5-C) その他のﾀｰｹﾞｯﾄ･ｹｰﾌﾞﾙ(“1./RESET”、“3.DGCLK”、
“4.DGDATA”と捺印された）先端部をﾀｰｹﾞｯﾄ･ｼｽﾃﾑ上の同じ表示
のピン・ヘッダに接続します。

⑥ ﾀｰｹﾞｯﾄ･ｼｽﾃﾑの電源を入れます。
MODEスイッチの設定を3Vにした場合、この操作は不要です。

(5-C)

(5-C)

① MODEスイッチ

④ターゲット･ケーブル
接続コネクタ

DATA
CLK
VDD
/RST
GND (5-A)

(5-B)

⑤ターゲット・ケーブル

②ミニＢタイプ
USBケーブル ③ Power LED

※ PG-FPL2用コントロール･ソフトをインストールしてから接続してください。

準備編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

USBドライバのインストール

以下、ウィザードの指示に従って設定を行ってください。

『デバイスに最適なドライバを検索』する際、ドライバ・ファイルの
検索場所には下記フォルダを指定してください。

PG-FPL2とホストコンピュータを接続すると、プラグ＆プレイで新しい
ハードウエア(PG-FPL2)が認識され、『新しいハードウェアの検出ウィ
ザード』ダイアログが表示されます。

[注] PG-FPL2用コントロール・ソフトのインストール・フォルダを変更した場合は、
“変更したフォルダ¥bin¥PG-FPL2¥DRIVER”を検索場所に指定してください。

C:¥Program Files¥NECTools32¥bin¥PG-FPL2¥DRIVER [注]

準備編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

サンプル・プログラム

本製品に添付の“簡易ターゲットボード”と NECエレクトロニクス社
製開発ツールを使用して、プログラムの作成から動作確認、フラッシュ
書き込みまでの一連の操作を、実際のプログラムを用いて説明します。

ここでは 20pinの KA1+ で７個のLEDを点灯させるプログラムをタイ
マーと割り込みを使用して作成します。ターゲット・システムの回路構
成は、後述の『応用編 ターゲット・システム ブロック図』を参照して
ください。

コーディング、ビルド
(右図は PM+ の画面)

疑似ターゲットで動作確認
(左図は SM+ の入出力パネル画面)

内蔵フラッシュ・メモリへ
書き込み

体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

(Step1) Applilet編 (1/3)
Appliletを使って、デバイス・ドライバを作成します。

1. Appliletを起動します。
[スタート]→[プログラム(P)]→[NEC Electronics Tools]→
[Applilet for 78K0SKX1+]→[Vx.xx]→
[Applilet for 78K0SKX1+ Vx.xx]

2. Applilet設定用ファイルを新規に作成します。
メニューの[ファイル(F)]→[新規作成(N)...]を選択します。
『新規プロジェクト』ダイアログで、<プロジェクト名>と<チッ
プ・シリーズ>を設定してください。

<プロジェクト名>
mdt → 7LED に変更

<チップ・シリーズ>
シリーズ名：

78K0SKA1+ を選択
チップ名：

uPD78F9222 を選択

体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

(Step1) Applilet編 (2/3)
3. サンプル・プログラムで使用する周辺機能を設定します。

ウォッチドッグタイマ
設定ダイアログ：
“使用しない”に設定。

ポート設定ダイアログ：
下記のポートを
“出力”、“１”に設定。
[ポート２]タブの P20、P21、P22、P23
[ポート４]タブの P40、P41、P42

タイマ設定ダイアログ:
[タイマ00]タブ
<タイマ00機能>エリアの
“インターバル・タイマ”にチェック、
[詳細]ボタンをクリック。

TM00インターバル・タイマダイアログ：
<設定単位> を msec に設定、
<割り込み設定>エリアの“設定した周期
毎に通知する“にチェック。

システム設定ダイアログ：

[基本設定]タブ
<内蔵発振器オプション･バイト設定>エリアの
“低速内蔵発振器はソフトウェアによる停止可能”にチェック。

<RESET入力>エリアの
“P34/RESETをRESET端子として使用する”にチェック。

体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

4. ソースコードの自動生成
4-1) コンパイラ(CC78K0S)のパスを設定します。

コンパイラを C:¥NECTools32 以外の場所にインストールして
いる場合は、メニューの [オプション(O)]→[コンパイラ選択]
→[パス設定...] でコンパイラのパスを設定してください。

4-2) アイコンボタン を押してください。

(Step1) Applilet編 (3/3)

4-3) <ドライブとフォルダ選択> でコード生成する場所を確認して、
[コード生成]ボタンを押してください。

注意：コード生成するフォルダ名およびパス名に、空白文字
や漢字などの2バイト文字は使用しないでください。

5.『ファイルの生成を完了しました』ダイアログが表示され、
デバイス・ドライバの生成は完了です。

体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

次に、LEDを制御するプログラムをＣ言語で記述します。

1. PM+ を起動します。
[スタート]→[プログラム(P)]→[NEC Tools32]→PM plus

2. ワークスペース(7LED.prw)を開きます。
メニューの[ファイル(F)]→[ワークスペースを開く(W)...] を選
択します。
『ワークスペースを開く』ダイアログで、Applilet編の手順 4-2)

で指定したディレクトリの“7LED.prw”を指定して、[開く(O)] ボ
タンを押してください。

(Step2) PM+編 (コーディング）
体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

(Step3) PM+編（ビルド）
3. LEDを点灯させる部分のソース・コードを記述します。
下記に示す色の付いた部分のコードを追加してください。

3-1) PM+ の ProjectWindow で main.c をダブルクリックしてエディ
タを起動します。main関数にタイマーをスタートさせる
『TM00_Start(); 』の呼び出しを追加します。

/* LED点灯用配列データ */
char light_data[] = 
{ 0xFF, 0xFE, 0xFD, 0xFB, 0xF7, 0xEF, 0xDF, 0xBF,
0xFF, 0xBF, 0xDF, 0xEF, 0xF7, 0xFB, 0xFD, 0xFE  };

int idx = 0;

__interrupt void MD_INTTM000( )
{
/*TODO*/
if( idx >= sizeof(light_data) ) {
idx = 0;

}
P2 = ( P2 | 0x0F ) & (light_data[idx] & 0x0f);
P4 = ( P4 | 0x07 ) & ((light_data[idx] & 0x70)>>4 );
idx++;

}

void main( void )
{
/* TODO. add user code */
TM00_Start();
while(1){
;

}
}

4. メニューの[ビルド(B)]→[ビルド(B)]を実行してください。
記述したソースに誤りが無ければ、
『ビルドが正常に終了しました。』のダイアログが表示されます。

3-2) 同様に TIMER_user.c をダブルクリックして、グローバル変数に
LED点灯用配列データとデータ参照用のインデックス、そして割
り込み関数 MD_INTTM000( ); に下記コードを追加します。

体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

(Step4) SM+ for 78K0S/Kx1+編(起動)

2. PM+ から SM+ を起動します。
PM+メニューの[ﾋﾞﾙﾄﾞ(B)]→[ﾃﾞｨﾊﾞｯｸﾞ(D)]を選択して、SM+ for 

78K0S/Kx1+ の 『Configuration』ダイアログを表示します。
Oscillation Frequency の値を 8.00 MHz に設定して、[OK] ボタン
を押してください。
ダウンロード確認のダイアログが表示されますので、[OK]ボタンを

押してください。

1. PM+ から 連携起動するシミュレータを設定します。
PM+メニューの[ﾂｰﾙ(T)]→[ﾃﾞｨﾊﾞｯｶﾞの設定(D)...]を選択します。

『ﾃﾞｨﾊﾞｯｶﾞの設定』ダイアログのプルダウンメニューで、選択ﾃﾞｨ
ﾊﾞｯｶﾞに“SM+ for 78K0S/Kx1+ ｼｽﾃﾑ･ｼﾐｭﾚｰﾀ”を設定します。

プログラムのビルドが終了したら、シミュレータ(SM+ for 78K0S/Kx1+)
でプログラムの動作を確認します。

Oscillation Frequency の
値は、Appliletの『システム
設定ダイアログ』の発振設定
と同じ値を設定してください。

体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

(Step4) SM+ for 78K0S/Kx1+編(疑似ﾀｰｹﾞｯﾄ)
LED点灯が正しく動作しているかを、シミュレータ(SM+ for 78K0S)の

入出力パネルに擬似ターゲット・システムを構築して確認します。

3. SM+ の入出力パネルに、LEDやRESETボタンなどの部品を配置します。

3-1) SM+メニューの[ｼﾐｭﾚｰﾀ(S)]→[入出力パネル(P)]を選択して、
『入出力パネル１』を表示します。

3-2)『入出力パネル１』をアクティブにした状態で、SM+メニューの
[部品(P)]→[LED(E)]を選択、『入出力パネル１』に任意の大きさ
のLEDを貼り付けます。(この操作を7回繰り返します。）

3-3) 同様に[部品(P)]→[ボタン(B)]を選択して、『入出力パネル１』
に任意の大きさのボタンを貼り付けます。

3-4) 部品の上で右クリック→[ﾌﾟﾛﾊﾟﾃｨ(R)]を選択して表示される
『Parts Led(Button) Properties』ダイアログで、端子等を設定
します。

ボタンの上で右クリック→[ﾌﾟﾛﾊﾟﾃｨ(R)]を
選択して、下記の値を設定します。
“ラベル：RESET”、
“接続端子：RESET”、
“アクティブレベル：LOW”

LEDの上で右クリック→[ﾌﾟﾛﾊﾟﾃｨ(R)]を選択して、
下記の値を設定します。
“接続端子：P42”
“アクティブレベル：LOW”

（接続端子は、左端のLEDから順に
P42、P41、P40、P23、P22、P21、P20 を設定。）

体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

(Step4) SM+ for 78K0S/Kx1+編(実行確認)

4. [Restart]ボタン を押して、シミュレーションを実行します。
シミュレーション中は、ステータス・バーが赤く表示されます。

ステータス・バー
LEDの点灯確認：
プログラムが正しく動作していれば、点灯したLEDが下図のように

右から左、左から右へと移動するように見えます。

体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

(Step5) PG-FPL2編 (1/2)
動作確認の終了したプログラムを、フラッシュ・メモリへ書き込み
ます。

1. PG-FPL2とターゲット･システム、ホストコンピュータを接続します。
MODEスイッチは“3V”に設定してください。接続方法の詳細は、

準備編『PG-FPL2の接続方法』をご参照ください。

2. PG-FPL2用コントロール・ソフトを起動します。
[スタート]→[プログラム(P)]→[NEC Tools32]→PG-FPL2

3. パラメータ・ファイルを読み込みます。
メニューの[Device]→[Setup...]を選択して、『Device Setup』

ダイアログを表示します。
[Standard]タブの[PRM File Read]ボタンを押して、uPD78F9222用
のパラメータ・ファイル“78F9222.PRM”を開いてください。[注]

正しく読み込めた時は、
『PRM File Read OK.』
と表示されます。

[注] パラメータ・ファイルは、任意のディレクトリに解凍したファイルを指定し
てください。

体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

(Step5) PG-FPL2編 (2/2)

4.ターゲット・デバイスにプログラムを書き込みます。

4-1) メニューの[File]→[Load...]を選択します。
『ファイルを開く』ダイアログで、書き込み対象のプログラムを
指定してください。

4-2) 次に、[Device]メニュー→[Autoprocedure(EPV)]を選択するか、

または ボタンを押してください。

μPD78F9222に対して、メモリの消去後、プログラムの書き込
みを順番に実行します。

5.システムの終了

5-1) [File]→[Quit]を選択して、PG-FPL2用コントロール・ソフトを
終了します。

5-2) ターゲット・システムから、ターゲット・ケーブルを外します。

5-3) USBケーブルを PG-FPL2 から外します。

正しく書き込めた時は、
『... finish!』
と表示されます。

体験編
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はじめに 準備編 体験編 応用編

クイック・スタート・ガイド

応用編 書き込み完了データの保護
小ピン・マイコン(78K0S/Kx1+)は、内蔵フラッシュ･メモリの書き換え
禁止機能（セキュリティ機能）をサポートしています。この機能によっ
て、フラッシュ・メモリに書き込まれたプログラムの第三者による改竄
を防止することができます。

注意!!  セキュリティ機能は、フラッシュ・メモリのデータを
保護するために、書き込み・消去ができなくなります。
設定時には十分ご注意ください。

書き込んだ
データに対する
保護オプション

PG-FPL2に接続されたターゲット・デバイスのセキュリティ・フラグは、
PG-FPL2用コントロール・ソフトで設定できます。

1. セキュリティ・フラグの選択
コントロール・ソフトのメニュー [Device]→[Setup...] を選択
して、『Device Setup』ダイアログを表示します。
[Advance]タブの、<Security flag settings>エリアで、有効にする
セキュリティ機能にチェックを入れます。

2. セキュリティ・フラグの設定
コントロール・ソフトのメニュー[Device]→[Security]を選択す
ると PG-FPL2に接続されたターゲット・デバイスのセキュリティ・
フラグのプログラミングを実行します。

セキュリティ機能の詳細は、
各デバイスのユーザーズ・マニュアルを参照してください。

応用編
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応用編 ターゲット･システム ブロック図
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